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About This Manual

Use this manual to familiarize yourself with the DIAdem environment and 
the basic DIAdem features you use to evaluate and present your data.

This manual contains exercises to teach you how to load data, perform 
basic evaluations of your data, analyze data sets, automate functions in 
your data, and create presentations for your data. These exercises take a 
short amount of time to complete and help you get started with DIAdem.

Throughout each exercise, you will see illustrations that provide 
information about the concepts associated with the steps. The end of 
each chapter includes a summary of the main concepts taught in that 
chapter. Use these summaries to review what you learned.

Conventions
The following conventions appear in this manual:

<> Angle brackets indicate a key you press to perform a function, for example, 
<Ctrl>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a tip, which alerts you to advisory information.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
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programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• DIAdem: Data Analysis and Report Generation

• DIAdem Help, available by selecting Help»Contents
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1
Creating a Presentation 
with DIAdem

DIAdem organizes various sets of functions in panels. Using different 
panels, you can load, analyze, calculate, and present your data. You also 
can automate repeated tasks for simplified use. Each panel provides 
powerful tools to complete the following tasks:

• Manage data with DIAdem NAVIGATOR.

• View data with DIAdem VIEW.

• Evaluate data with DIAdem ANALYSIS.

• Generate reports with DIAdem REPORT.

• Automate repeated tasks with DIAdem SCRIPT.

• Link data with videos and 3D models using DIAdem CLIP and 
DIAdem INSIGHT.

In the following exercise, you will use basic features of DIAdem to create 
your first presentation.

Using the Report Wizard
The Report Wizard allows you to create a report by selecting the data and 
the layout from a dialog box.

Note If the Report Wizard does not appear before you start the following exercise, press 
<Ctrl-W> to activate the Report Wizard. You also can start the Report Wizard from the 
toolbar in DIAdem VIEW and DIAdem REPORT.

Complete the following steps to create a report with the Report Wizard.

1. Click Next.

2. Select SQL: Default SQL from Data Sources.

3. Click + next to ..\National Instruments\Shared\USI\
Examples\SQL\simple.mdb.

4. Select Example.
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Figure 1-1.  Creating a Report with the Report Wizard

5. Click Finish. DIAdem displays the report you just created with the 
Report Wizard.

Note You can deactivate the Report Wizard by selecting Settings»Desktop Parameters»
General and deselecting Report Wizard»Start with DIAdem. You also can deselect 
Start Wizard with DIAdem in the Report Wizard. You do not need the Report Wizard to 
complete the remaining exercises in this manual.

Loading Data
DIAdem NAVIGATOR offers access to data files and databases. The data 
used in DIAdem represent measurements that you have taken, information 
that you have loaded into DIAdem, and calculations you have performed 
on raw data.

Complete the following steps to load data into the Data Portal.

1. Select the DIAdem NAVIGATOR panel.

2. Click Delete Internal Data.

3. Select the path My DIAdem 9.1\DIAdem Demo.

4. Select the data file Data1.tdm.

5. Drag and drop the data file Data1.tdm to the Data Portal on the right 
of the screen.



Chapter 1 Creating a Presentation with DIAdem

© National Instruments Ireland Resources Limited 1-3 Getting Started with DIAdem

Figure 1-2.  Loading Data from DIAdem NAVIGATOR to the Data Portal

Creating a Report
With DIAdem, you can create presentations from layouts that you 
configure yourself or from existing templates. Complete the following 
steps to create a presentation for the data you just loaded into the Data 
Portal.

1. Select the DIAdem REPORT panel.

2. Click Load Layout.

3. Select the layout file Report1.tdr in the ..\DIAdem 9.1\Demo\

Gra folder and click Open.

4. Click Redraw.
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Figure 1-3.  Creating a Report from an Existing Template

Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Report Wizard
Use the Report Wizard to simplify the selection of data channels, curves, 
and layout with which DIAdem displays a report.

Panels
DIAdem contains different panels, each performing a specific set of 
functions. Each panel has a corresponding icon in the panel bar on the outer 
left of the DIAdem workspace. Selecting different panel icons changes the 
functions available in the DIAdem user interface.

Workspace
The workspace is where activities for each panel take place. For example, 
the workspace for DIAdem NAVIGATOR contains external data files and 
databases with different data sets, and the workspace for DIAdem 
REPORT contains the layouts with axis systems, tables, text, and graphics. 
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Toolbar
Each panel in DIAdem has its own toolbar that provides specific functions 
for that panel.

Data Portal
The Data Portal organizes internal data in DIAdem. Use the Data Portal to 
access internal data in DIAdem. You can drag and drop channels from the 
Data Portal into the workspace of different panels.

DIAdem NAVIGATOR
DIAdem NAVIGATOR shows the structure of external data. Use DIAdem 
NAVIGATOR to access external data to load into the Data Portal.

DIAdem REPORT
With DIAdem REPORT, you can create reports for your data. You can then 
save report layouts as templates to use for future reports of your data.
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2
Managing Your Data

Data from files and databases is the fundamental element of DIAdem. With 
DIAdem NAVIGATOR, you can browse, load, and save your data.

Loading Data
Complete the following steps to load data into the Data Portal.

1. Select the DIAdem NAVIGATOR panel.

2. Click Delete Internal Data.

3. Select File Based Data Storage from the group bar.

4. Select All registered data files from the function bar.

5. Select the data path My DIAdem 9.1\DIAdem Demo.

6. Select the data file Data2.tdm.

7. Drag and drop Data2.tdm to the Data Portal.

Figure 2-1.  Loading Data from DIAdem NAVIGATOR to the Data Portal
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Organizing Data
You can organize and remove data in the Data Portal to focus on the 
data that you want to analyze. Complete the following steps to remove 
unwanted data.

1. Select the channel Precipitation.

2. Scroll down in the Data Portal until the last channel appears.

3. Press <Shift> and click the data channel AverYearRain. The 
data channels between the channel Precipitation and the channel 
AverYearRain appear highlighted.

4. Press <Delete>.

5. Click OK.

The data channels Date, T_min, and T_max are the only channels 
remaining in the Data Portal under the channel group Weather.

Saving Data
Complete the following steps to save your data.

1. Select the path My DIAdem 9.1\DIAdem Demo in 
DIAdem NAVIGATOR.

2. Select the channel group WEATHER in the Data Portal.

3. Drag and drop WEATHER into the Demo path.

4. Enter DataWeather.tdm in the Save As dialog box.

5. Click Save.

Figure 2-2.  Saving Data in DIAdem NAVIGATOR
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Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

DIAdem NAVIGATOR
DIAdem NAVIGATOR shows the external data structure in different hard 
drives, directories, and servers. Use DIAdem NAVIGATOR to find the 
external data that you wish to load into DIAdem and to save internal data 
that you have processed in DIAdem.

External Data
External data represents the data saved outside of DIAdem in the form of 
data files and databases. DIAdem shows the organization and hierarchy of 
external data in DIAdem NAVIGATOR.

Data Portal
Internal data in the Data Portal represents the data channels and descriptive 
information used by the various panels inside of DIAdem.

DIAdem does not automatically save changes when you modify data in the 
Data Portal. If you process or modify the data currently loaded in the Data 
Portal, processing the data affects only the data in the memory, not the 
source data file or database from which the data was loaded. This helps 
to avoid accidental modifications to your data and results. You can 
experiment with your data while avoiding the risk of destroying the original 
data file or database.

Tip In addition to clicking directly on channels to select them in the Data Portal, you 
can click on the symbols next to channels to select and deselect them. By clicking on the 
symbols next to the channels, you can select several channels without pressing <Shift> 
or <Ctrl>.

Figure 2-3.  Selecting Channels with the Selection Cursor
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Channel Groups
Channel groups in the Data Portal represent a collection of data channels 
that you have acquired during an experiment or calculated in an evaluation.

Data Channels
Data channels in the Data Portal represent the measurement data from 
individual test sensors recorded during a test, data series loaded from an 
external data file, or a new channel resulting from a calculation.

Function Bars
In the function bars, prepared views of external data are available for 
file-based and server-based data storage.
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3
Viewing and Editing Data

With DIAdem VIEW, you can view and analyze data graphically in 
different screen layouts. You also can view and edit data points numerically 
in tables.

Viewing Curves
Complete the following steps to view the weather data in an axis system.

Note If you have not completed the exercise from Chapter 2, Managing Your Data, load 
the data set Data3.tdm located in DIAdem Demo.

1. Select the DIAdem VIEW panel.

2. Click New Layout.

3. Click Regular Screen Partitioning in the group bar.

4. Click Two Areas in the function bar.

5. Right-click in the lower worksheet area and select Display Type» 
2D Axis System.

6. Select the data channel Date.

7. Press <Ctrl> and select the data channel T_min in the Data Portal.

Note When selecting data, the first channel you select, in this case Date, is assigned to the 
x-axis. The subsequent channels appear as curves.

8. Drag and drop the channels selected in the Data Portal into the lower 
worksheet area.

9. Select the data channel Date.

10. Press <Ctrl> and select the data channel T_max in the Data Portal.
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11. Drag and drop the channels selected in the Data Portal into the lower 
area. DIAdem updates the display area with an additional curve.

12. To display the legend, hold the mouse cursor over the right edge of the 
area and drag the mouse to the left.

Note You must select both an x- and y-channel for the display in the DIAdem VIEW 
worksheet.

Figure 3-1.  Viewing Temperature Data as Curves

Working with Tables
Tables allow you to view and edit data channels numerically.

Creating a Table
You can display and edit data points in DIAdem VIEW. Complete the 
following steps to create a table in DIAdem VIEW.

1. Right-click in the top area and select Display Type»Channel Table 
from the shortcut menu.

2. Press <Shift> and click the Date and T_max data channels from the 
Data Portal. All the data channels are selected.
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3. Drag and drop the channels selected in the Data Portal into the upper 
worksheet area.

Note The columns appear in the order you select data channels in the Data Portal.

Figure 3-2.  Creating a Table with Data Channels

Editing a Table
Complete the following steps to edit the values in a table cell.

1. Click the cell in the channel T_max, row 10.

2. Enter the value 50 and press <Enter>. After pressing <Enter>, 
the curves in the axis system area change showing the newly entered 
data point.
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Using the Curve Cursor
Complete the following steps to use the curve cursor to follow the specific 
values of a curve in an axis system.

1. Click Curve Cursor in the toolbar.

2. Click the crosshairs of the curve cursor. Drag the curve cursor along 
the curve. If the crosshairs do not appear in the axis system, click in the 
axis system.

3. Right-click in the axis system area and make sure Display 
Coordinates is selected. As you move the curve cursor, DIAdem 
displays the x- and y-values of the data points in the Coordinates 
window.

4. Click the checkboxes on the right side of the axis system area to 
specify which curve coordinates DIAdem displays in the Coordinates 
window.

Zooming Curves
You can zoom curves in DIAdem VIEW to examine specific portions of 
curves more closely.

Choosing an Area to Zoom
Complete the following steps to adjust the band cursor to examine a 
specific section of the curve.

1. Click Band Cursor.

2. Adjust the width of the band by moving the mouse cursor over one 
of the Band Cursor elements. The cursor changes to a double-sided 
arrow. Now adjust the width of the band cursor.

3. Drag the Band Cursor to the segment of the curve that you want to 
examine.

4. Click Zoom, Static in the axis system toolbar to zoom a selected area.

5. Click Zoom Off in the axis system toolbar to return from the zoomed 
area to the entire area.
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Zooming Dynamically
Complete the following steps to scroll along the curves in the axis system 
within a specific range.

1. Right-click in the axis system area and select New Area»Bottom 
from the shortcut menu. A new workspace area appears below the 
axis system.

2. Right-click in the bottom area and select Display Type»2D Axis 
System from the shortcut menu.

3. Press <Ctrl> and click next to each legend curve symbol one at a time 
in the top axis system. 

4. Drag and drop the selected curves into the bottom axis system.

5. Click Zoom, Dynamic in the toolbar of the bottom axis system.

6. Click inside the band cursor in the top axis system to scroll the zoomed 
curves in the bottom axis system area.

Figure 3-3.  Creating a Zoomed View
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Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Curves
Curves graphically represent the relationship between x and y-channels.

Axis System
An axis system is where you can display curves of your data set. With an 
axis system composed of an x-channel and multiple y-channels, you can 
view how your data relate to each other.

Tables
In tables, you can view the individual data points for data channels. 
You also can edit data points for data channels in tables.

Textboxes
You can double-click to enter text and variable information, such as the 
current date. In textboxes you can display text channels.

Cursors
DIAdem VIEW provides a variety of cursors to analyze your data. With the 
curve cursors, you can run along a curve and analyze individual values. 
You also can use cursors to locate minimum and maximum values within 
a curve. The band and frame cursors allow you to concentrate on specific 
portions of data.

Zooming
Zooming allows you to focus on a specific range in an axis system. You can 
either zoom an area of an axis system statically, if you are certain of a 
specific area or you can zoom an area of an axis system dynamically, if you 
wish to scroll along a zoomed axis system.
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4
Analyzing Data Mathematically

With DIAdem ANALYSIS you can apply predefined mathematical 
functions, including basic math, curve fitting, signal analysis, and statistics. 
You also can perform your own calculations using the Calculator.

Using Standard Mathematical Functions
With DIAdem ANALYSIS, you can perform mathematical functions on 
your data. Complete the following steps to find the average (mean) of the 
minimum and maximum temperatures.

Note If you have not completed the exercise from Chapter 3, Viewing and Editing Data, 
load the data set Data3.TDM located in DIAdem Demo.

1. Select the DIAdem ANALYSIS panel.

2. Right-click Data2 in the Data Portal and select New»Group from the 
shortcut menu.

3. Enter Results and click OK.

4. Right-click Results and select Set Default Group from the shortcut 
menu. The default group Results now appears in bold in the Data 
Portal.

5. Click Basic Mathematics Functions in the group bar.

6. Click Average Channels in the function bar.

7. Select Weather/T_min in the Data Portal.

8. Press <Ctrl> and select Weather/T_max.

9. Drag and drop the selected channels into the Channels to be averaged 
field in the Averaging of multiple channels dialog box.
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Figure 4-1.  Averaging Minimum and Maximum Temperatures

10. Click Execute.

Note After you click Execute, DIAdem displays the input and result channels from the 
calculation in the workspace.

11. Right-click Results/Mean_values in the Data Portal and select 
Rename.

12. Enter T_avg as the channel name and press <Enter>.

Figure 4-2.  Calculating with Standard Mathematical Functions
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Calculating Formulas with the Calculator
Use the Calculator in DIAdem to perform your own mathematical 
operations. Complete the following steps to convert the average 
temperature from °C to °F.

1. Click Calculator.

2. Enter the following formula in the Edit area of the calculator:

Ch('Results/T_avg_F'):=('Results/T_avg'*1.8)+32

Figure 4-3.  Calculating Formulas with the Calculator

3. Click Calculate.

4. Click Close. The new data channel, Results/T_avg_F, appears in 
the Data Portal.
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Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Mathematical Functions
DIAdem ANALYSIS offers you a variety of functions for analyzing your 
data. You assign data channels to the function and then execute it. DIAdem 
stores newly calculated data in a new data channel.

Default Group
In the Data Portal, DIAdem deposits each result channel of a calculation in 
the default group. By configuring the default group, you choose where to 
save results. DIAdem labels the default group in bold.

Result Channels
After performing calculations in DIAdem ANALYSIS, the results appear 
in new data channels. This enables you to evaluate your data without 
deleting the existing data channels. You also can choose to overwrite 
existing data channels.

Calculator
The Calculator allows you to create your own formulas for analyzing your 
data. From simple arithmetic to advanced scientific and engineering 
formulas, use the Calculator to examine your data.
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5
Creating a Report

With DIAdem REPORT, you create reports for your data. Different 
objects can be added to a worksheet in DIAdem REPORT, including 
two-dimensional and three-dimensional axis systems and tables, polar 
coordinate plots, text, and variables, as well as graphics files. With 
DIAdem REPORT you can make informative reports.

Creating a New Layout
Complete the following steps to create a new layout.

Note If you have not completed the exercise from Chapter 4, Analyzing Data 
Mathematically, load the data set Data4.TDM located in DIAdem Demo.

1. Select the DIAdem REPORT panel.

2. Click New.

3. Click 2D Axis System in the group bar.

4. Click 2D Axis System with Grid in the function bar. A small square 
appears at the cursor.

5. Drag the frame open where you want to have the 2D axis system. 

6. Select the channel Weather/Date in the Data Portal.

7. Press <Shift> and select the channel Results/T_avg in the Data Portal.

Note When selecting the data channels, you must select the data channel Weather/Date 
first.

8. Drag and drop the data channels into the axis system.

9. Double-click the axis system.

10. Select the Legend checkbox.

11. Click OK.
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12. Click in the worksheet outside the axis system.

13. Click the legend and move it within the worksheet. 

14. Size the legend by dragging the small square blocks on the edges of the 
legend with your mouse cursor.

Figure 5-1.  Inserting an Axis System with a Legend into a Worksheet

Adding Graphics to Your Layout
You can enhance the appearance of your worksheet by adding graphics 
and company logos. Complete the following steps to add a graphic to your 
worksheet.

1. Click Graphics file in the group bar.

2. Click Load Graphics in the function bar.

3. Choose Weather.wmf in the ..\DIAdem 9.1\Demo\Gra folder and 
click OK.

4. Click the mouse button on the graphic and drag the graphic anywhere 
you want in the worksheet.

5. Size the graphic by dragging the small square blocks on the edges 
of the graphic with your mouse cursor.
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Labeling Your Report
You can add text to the worksheet to explain the information shown in the 
report. Complete the following steps to label your presentation.

1. Click Decorations in the group bar.

2. Click Text in the function bar. The cursor changes to a text cursor.

3. Click the position in the worksheet where you want to add your text 
input.

4. Enter the following text: Report Date: @CurrDateTime@ and 
press <Enter>.

Figure 5-2.  Labeling a Report with Variables

Inserting a Table
Complete the following steps to insert a table into your worksheet.

1. Click 2D Table in the group bar.

2. Click 2D Table with Horizontal and Vertical Separators in the 
function bar. A small square appears at the cursor.

3. Drag the frame open where you want to have the table. 

4. Click the mouse button on the table and drag the table anywhere you 
want in the worksheet.
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5. Size the table by dragging the small square blocks on the edges of the 
table with your mouse cursor.

6. Select the channel Weather/Date.

7. Press <Ctrl> and select the channel Results/T_Avg. Drag and drop the 
selected channels into the first column of the table.

8. Double-click the table.

9. Select the first channel and click Columns.

10. Enter the format #mm/dd/yyyy.

11. Click OK.

12. Select the second channel and click Columns.

13. Enter the format d.d.

14. Click OK twice.

15. Click Data Portal to hide the Data Portal.

Figure 5-3.  A Finished Report
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Making a Template
You can reuse this layout for additional temperature reports. Complete the 
following steps to use this layout with other data sets.

1. Click Save Layout As.

2. Enter the filename MyReport.TDR and click Save. If a report file with 
this name already exists, you can overwrite the file. After saving the 
layout, you can use it with any data file that has a similar structure.

Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Layouts
The layout is saved separately from the data channels. Use the layout as a 
template for data files with a similar structure.

Reports
When you fill a layout with data, you create a report. A report can contain 
several worksheets.

Select File»Append Layout to import existing layouts.

Worksheets
You can add axis systems, graphics, text, and tables to your worksheet. Add 
data to the worksheet by dragging and dropping data channels from the 
Data Portal into axis systems and tables.

In addition to selecting data channels from the Data Portal, you also can add 
data channels by double-clicking in an axis system or table.

Axis Systems
An axis system allows you to display data channels as curves in a report. 
Each axis system can accommodate up to 250 curves.

Tables
Use tables to show important channel data in your layout numerically.
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Decorations
You can insert comments, lines, arrows, rectangles, and circles into your 
report, to highlight certain areas or curve points.

Graphics
You also can customize layouts with graphics and company logos. 
DIAdem supports a number of different graphic formats including BMP, 
JPEG, TIFF, and WMF.

Text
You can add text to your layouts. Text can be text you enter as well as 
information provided from variables such as the filename and the current 
date. These variables are updated each time you redraw your report.
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6
Creating and Using Scripts

With DIAdem SCRIPT, you can create scripts to automate sequences in 
DIAdem. A script is basically a macro that you can extend to include 
programming structures, user-defined variables, and dialogs.

Creating a Script
In order to create a script, you have to start recording. Complete the 
following steps to record a script.

1. Select the DIAdem SCRIPT panel.

2. Click Enable Recording Mode to start recording the script.

DIAdem SCRIPT prompts you to enter the script author and 
comments. It places these items directly into the script code 
to help you identify the script in the future.

3. Enter DIAdem User for the Author and First Script for the 
Comments.

4. Select VBS Script for the Template Type.

5. Click OK.

Figure 6-1.  Configuring the Script Recording Mode
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Recording a Script
The recording mode saves all the actions that you complete interactively in 
a script. Complete the following steps to record actions in a script.

1. Select the DIAdem NAVIGATOR panel.

2. Click Delete internal data in DIAdem NAVIGATOR to clear the 
Data Portal.

3. Click Load data.

4. Choose the data set Data3.tdm in the ..\DIAdem 9.1\Demo\Dat 
folder and click Load.

5. Select DIAdem ANALYSIS panel.

6. Click Basic mathematic functions in the group bar. 

7. Click Average Channels in the function bar.

8. Click ... in the Averaging of Multiple Channels dialog box.

9. Press <Shift> and select [1]/T_min and [1]/T_max.

10. Click Execute.

11. Select the DIAdem REPORT panel.

12. Click Load layout.

13. Select the layout Report2.tdr and click Open. 

The screen automatically refreshes to show the data set you have just 
loaded.

14. Select the DIAdem SCRIPT panel.

15. Click Disable Recording Mode.

16. Click OK.
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Figure 6-2.  Recording a Script

17. Click Save File As.

18. Enter the name MyScript.VBS and click Save.

Running a Script
Now that you have recorded a script, complete the following to test the 
results:

Click Run Script. Notice the time displayed in the report refreshes each 
time you run the script.
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Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Scripts
Scripts allow you to execute a series of commands for loading data, 
analyzing data, and creating a report, using Visual Basic Script (VBS).

Recording Scripts
After you click OK in the Configure Recording Mode dialog box, the text 
Recording mode is enabled appears in the status bar. This indicates 
that you have successfully started recording your script. Every DIAdem 
command you perform will be recorded in the script file. Click Disable 
Recording Mode to stop recording a script.

Script Editor
The script editor displays header information and code for your script. 
DIAdem SCRIPT displays the actions that you perform while the recording 
mode in DIAdem SCRIPT is activated in the script editor. Use the 
debugger in the script editor to work through scripts step by step and to 
find errors.

Running Scripts
When you execute a script, the script performs all the actions you 
performed while recording commands.
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7
Linking Data to Videos and 
Models

DIAdem CLIP and DIAdem INSIGHT help you visualize test data in 
combination with videos and 3D models.

Creating a Video Scene
All the available data types are in the Data Window on the right of the 
DIAdem CLIP screen. In the workspace, you create scenes using videos, 
DIAdem data, and axis systems.

Note DIAdem CLIP is an external program you must install separately from DIAdem.

Complete the following steps to create a scene in DIAdem CLIP.

1. Start DIAdem CLIP.

A prepared layout appears in the workspace with one video area, 
one axis system area, and one picture area.

2. Click the Films tab in the Data Window.

3. Drag and drop the frontcrash.avi video into the video area. The video 
was recorded during a crash test.

4. Click the DIAdem Data Files tab in the Data Window.

5. Click + next to open the frontcrash data set.

6. Press <Ctrl> and select all the data channels.

7. Drag and drop the selected data channels into the axis system.

8. Click the Graphic Files tab in the Data Window.

9. Drag and drop fcrash.jpg into the picture area.
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Figure 7-1.  DIAdem CLIP Scene of a Front Crash Test

Evaluating a Video Scene
Once you have created a scene, you can correlate the measurement data 
with the video. Complete the following steps to evaluate your videos and 
data.

1. To run the evaluation, click Play Once. 

2. To run the evaluation repeatedly, click Play Continuously.

3. Move the Speed slider to adjust the playback speed.

4. Click Stop.

5. Click in the axis system, click the mouse button and move the line 
cursor, for more detailed examination. When you keep the line cursor 
stationary, the video synchronizes automatically.

The axis system legend shows the measurement values you point to 
with the line cursor.



Chapter 7 Linking Data to Videos and Models

© National Instruments Ireland Resources Limited 7-3 Getting Started with DIAdem

Creating a 3D Model Scene
With DIAdem INSIGHT, you project measurement data onto a model of a 
measurement object. The measured values are displayed as color shading, 
deformation, or size changing in your 3D model.

Note DIAdem INSIGHT is an external program you must install separately.

In the following exercise, you assign data to a metal plate with temperature 
sensors mounted at regular intervals. Complete the following steps to 
assign data channels to the model.

1. Start DIAdem INSIGHT. In the workspace you see a prepared layout 
with a model area.

2. Click the Model Files tab in the Data Window.

3. Drag and drop plate.mod into the model area.

4. Click the DIAdem Data Files tab in the Data Window.

5. Click + next to open the plate data set. 

6. Drag and drop the data channel Temp_1 to a model point on a grid line 
intersection. The model points are indicated by circles on the grid line 
intersections.

Note If you do not drag and drop a channel to a precise model point, a message appears 
for you to assign the channel again. You can zoom the model to see the model points better.

7. Select Color from the Displaying Data As dialog box.

8. Click OK.

9. Repeat steps 6 through 8 for data channels Temp_2, Temp_3, and 
Temp_4.

10. Press <Ctrl> and select the channels Temp_1, Temp_2, Temp_3, and 
Temp_4.

11. Drag and drop the channels into the axis system area.

12. Click the Graphic Files tab in the Data Window.

13. Drag and drop plate.jpg into the picture area.
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Figure 7-2.  DIAdem INSIGHT Scene Projecting Temperatures on a 3D Model

Evaluating a 3D Model Scene
Once you have created the scene, you can compare the measurement data 
with the model simulation.

Complete the following steps to evaluate the model and data.

1. Click Play once to run the whole evaluation.

2. Click in the axis system and move the line cursor, for more detailed 
examination.

You can zoom, move, and rotate the model in the model window.

• Zoom the model with the right mouse button, moving the mouse 
horizontally at the same time.

• Rotate the model with the left mouse button.
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Summary
The following topics are a summary of the main concepts that you learned 
in this chapter.

Scenes
A scene is composed of video, model, axis system, and picture elements.

Videos
Use videos that are recorded simultaneously with your measurement data 
to illustrate a test.

Models
Link the measurement signals to points on the 3D model where you 
acquired the data. You display the measured values on the model as 
color shading, deformation, or size changing.

Evaluations
After creating a scene, you can compare the measurement data and the 
videos. DIAdem CLIP and DIAdem INSIGHT offer two ways to perform 
your evaluation:

• Automatically, using the player bar. By running through the complete 
time channel you get an overview of the test.

• Manually, using the line cursor in the axis system. You can move from 
point to point in your graph to check critical or unclear ranges.
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A
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit the award-winning National Instruments Web site for 
software drivers and updates, a searchable KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, thousands 
of example programs, tutorials, application notes, instrument 
drivers, and so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Developer Exchange at 
ni.com/exchange. National Instruments Application Engineers 
make sure every question receives an answer.

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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